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I.  About the Online Injury Reporting System 

When do I need to use the online injury reporting system? 
You must complete the Online Injury Report within 24 hours of an incident when a child in your care 
has received emergency medical attention or has been hospitalized.  Other injuries can be 
documented using an “Accident/Injury Report form created by your facility.   

Can I continue to use my facility’s internal report form instead of the new 
Online Injury Reporting System for accidents resulting in injuries that 
require emergency medical attention or hospitalization? 
No, you may not continue to use your facilities own internal report form.  You must use the new 
Online Injury Reporting System.  If you are unable to access the system, you must use the new 
department approved hard copy form which must also be submitted within 24 hours. 

If the child did not require emergency medical attention or hospitalization 
can I use my facility’s internal report form? 
For non-emergency medical attention or hospitalization you may continue to use your own internal 
report form.  We have provided a link to a sample accident report form as a word document.  If you 
choose to use this sample accident report form you may change or revise it to suit your facility’s 
needs.  Remember that at any time a child is injured you must document the injury and notify the 
child’s parent or guardian. 

We had an incident where multiple children were injured, can I include 
them all in one injury report?  
No.  Each injury report follows a single child.  However, you have the option to create additional 
reports based on the initial injury report information.  The system can generate another injury report 
with currently entered incident information.  To enter a second report, complete the first report. When 
prompted, select Yes to create additional injury reports.  The system displays page one of the report 
with the reporter’s information and event details completed.  Enter the next child’s name and birth 
date and then modify the information regarding the child’s connection to the incident and the child’s 
injuries.   

It has been more than 24 hours since the child was injured, can I still use 
this report? 
Yes.  There is no cutoff date to file a report, although every attempt should be made to file an injury 
report within 24 hours of knowing of the incident.    

General Rules at 7.701.52A1 and A2 require that within 24 hours (excluding weekends and holidays) 
of the incident, the facility must report in writing to the licensing authority any injury to a child that 
requires emergency medical attention or admission to a hospital.   
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Do I need to create an online account to use the Injury report ? 
No.  To enter into the Injury Reporting System all you need is your license number to file a new 
report.   

What are the letters after the dash on my license number? 
The letters after the dash on the license number indicate the license type: 

• DCH – Day Care Home - Family Child Care Home 
• DCH3 – Day Care Home 3 - Family Child Care Home approved for 3 children under 2 years of age. 
• ECCP – Experienced Child Care Provider - Family Child Care Home  
• ITH – Infant Toddler Home - Family Child Care Home 
• LDCH – Large Day Care Home - Family Child Care Home 
• DCC – Day Care Center - Child Care Center 
• PRS – Preschool - Child Care Center 
• SACC – School Age Child Care  
• CPR – Resident Camp 

I have some photos and a doctor’s report I would like to include in the 
injury report.  Can I include electronic attachments?  
No, the injury reporting system does not allow you to submit electronic attachments.  To provide 
attachments to the report, send your attachments to your Licensing Specialist.   

• Email – The attachments can be emailed to your Licensing Specialist.  Their email address 
can be found on page 1 of 4 of the Injury Report.   

• Mail – The attachments can be mailed to your Licensing Specialist at the Department, at  
1575 Sherman St.  Denver, CO.  80203.   

• Hand Delivered – Any and all attachments can be delivered to your Licensing Specialist 
directly, at 1575 Sherman St.  Denver, CO.  80203.   

Be sure to include: 

• The facilities name and license number  
• The child’s name 
• The injury report ID, found on your confirmation email sent to you as a result of filing the injury report.   
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II.  Getting Started 

What is CRS 26-6-112? 
CRS stands for Colorado Revised Statutes.  These are laws, regulations, and codes for the State of 
Colorado.  The first number identifies the Title of grouping of codes.  In this instance, Title 26 covers 
the codes for Human Services.  The next number, Article, identifies the sub-grouping of codes or 
articles.  In this example Article 6 covers the Child Care Centers.  The final number identifies the 
specific code.  In this case code 112 identifies the penalties for making false statements or reports.   

What information do I need to begin an online Injury Report? 
To begin creating an online Injury report, you will need: 

• Your name and valid e-mail address 
• The Facility license number 
• The child’s first and last name and date of birth 

How do I add additional medical information to the Injury Report? 
If new medical information becomes available within ten days from the date of injury listed in the 
initial injury report, it can be added to the Medical Outcomes section.  If past ten days from the date 
of the injury, listed on the initial report, contact your licensing specialist. 

First select ACCEPT on the “Acceptance Page than select “ADD MEDICAL OUTCOME” on the 
“Instruction Page. 

To log in, you will need: 

• The facility’s license number 
• The Injury ID number from the initial report, found on your confirmation email sent to you as a 

result of filing the injury report.   
• The initial reporting party’s email address 
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III.  Navigating the Injury Report System 

I have completed a page, but the computer will not advance to the next 
page when I click continue? 
This report contains required fields.  You cannot continue if a required field was left blank.  Review 
the page to ensure that all required fields are complete.  An asterisk * with a message will appear 
next to the blank field.   

I started my report but had to attend to something else, I returned to my 
desk 10 to 15 minutes later and I could not advance to the next page, I 
had been logged out due to inactivity.  How do I get back to my report? 
In order to protect the information in the system, the Injury Report session ends after 10 minutes of 
inactivity.  All data is erased and you must begin again.   

Can I return to a page after I have moved on in the report? 
Yes.  Click Previous at the bottom-left of the screen to move back to previously completed sections of 
the report.  Any time before you submit the report you can move between the pages.   

When I click the Help button nothing displays, am I doing something 
wrong? 
In order for the Help documents to display, ensure your pop-up blocker is turned off.  

For Internet Explorer Users, the pop-up blocker is part of the browser’s Tools menu.  From an open 
browser, Click Tools > Internet Options > Privacy.  To turn off the Pop-up Blocker, deselect the Turn 
on Pop-up Blocker checkbox. 
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IV.  Correspondence 

Who receives a copy of this report? 
When you submit this report, both you and your licensing specialist receive a copy by email.   

What do I need to do with this report? 
You must keep a printed copy in the child’s records and provide a copy to the child’s parent or 
guardian. 
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V.  Identifying Information - Page One 

If the information about my facility is incorrect, can I still file the report 
online? 
Yes, you can still file the report online.  The information about your facility is based on the information 
we currently have in our computer system.  If this information is incorrect contact your licensing 
specialist as soon as possible to update your information.   

Who is my Licensing Specialist? 
Your licensing specialist’s name and email contact information displays on the first page of the report.   

Why do I need to enter my phone number and email address? 
Once submitted, the system sends the injury report to the email address you specify.  The phone 
number will be used to contact you if your licensing specialist needs additional information.   

There were several witness to the incident.  How do I list them all? 
You can add as many as 15 additional witnesses and parents to a report as necessary, but only one 
injured child per report.  Choose the number of additional lines from the dropdown box below the 
fields and then click the Add Lines button. 
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VI.  Injury or hospitalization – Page Two 

The child suffered a very serious injury and I do not know if the child has 
died.  How do I report this? 
At the top of page 2 of 4 there is a checkbox for ‘I Don’t Know’.  Use this if the child’s status is 
unknown.  You can also include a brief statement in the “If yes explain” field.  When the child’s status 
becomes known you can add and update the information as often as necessary to the Medical 
Outcomes section for up to ten days from the date of injury listed in the initial injury report.  If past ten 
days from the date of the injury, listed on the initial report, contact your licensing specialist. 

How do I state that the child has a medical condition that was a factor in 
the incident, but not the cause of the injury.   
Choose “If yes Explain” field and explain in the text box provided.  Select the “Body Type Injured and 
the “Circumstances Resulting in Medical, Attention” on page 2 of 4. 

In the course of the incident, the child suffered multiple injuries.  How do I 
report this? 
Select the applicable checkboxes (you can select more than one) in each sub-section of page 2 of 4.  
Use the “Describe the type and circumstances”… box at the bottom of the page to provide a narrative 
of the actual incident.   

How much space is there in the “Describe the type and circumstances” 
…box ? 
The Describe type and circumstances … box has plenty of space to describe the injury.  You can 
type or cut and paste a description that is over 7,000 characters long, or about 2 pages of typed text.   
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VII.  Equipment and Location – Page 3 

The incident in which the child was injured started inside but concluded 
outside.  The injury report will only let me choose one or the other, how 
do I describe the location? 
In general, list the location wherever the incident began.  Use the ‘Describe the type and 
circumstances”… field to include additional information regarding the location.   

. 
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VIII.  Medical Outcome, Submit and Print – Page Four 

The child was taken by a third party to the emergency room, I do not 
know what treatments were given.  How do I report this?  
Select from the “Treatment Given or Action Taken by Provider” section and then note any additional 
information such as “Transported to hospital by ambulance” or “Transported to the doctor by the 
parent” in the Describe the Diagnosis box.  You can add additional medical outcomes as they 
become known for up to ten days from the date of injury listed in the initial injury report.  If past ten 
days from the date of the injury, listed on the initial report, contact your licensing specialist. 

For the purposes of this report, who is considered a “Medical 
Professional”? 
For the purposes of this report a “Medial Professional” is an EMT, Paramedic, Nurse, Doctor, Dentist, 
etc., including anyone, who holds a current license to treat physical injuries beyond basic first aid.   

How much narrative can I include in the three text fields at the end of the 
Medical Outcomes section? 
Each of the text fields at the bottom of the Medical Outcomes section contains space for over 7,000 
characters in length, or about 2 pages of typed text.   

I have already submitted the report, but was just provided additional 
medical information, can I add this to the report? 
If new medical information becomes available within ten days from the date of injury listed in the 
initial injury report, you can add it to the Medical Outcomes section.  If past ten days from the date of 
the injury, listed on the initial report, contact your licensing specialist. 

Does adding a new medical outcome restart the 10-day reporting update 
period? 
No.  The reporting update period is based on the date of the injury listed in the initial injury report. 

I am trying to reopen an existing report.  Why can’t I see any previously 
entered information? 
Once submitted, the information from the Injury Report is no longer accessible.  This is done to help 
protect the child’s information and the integrity of the initial report.  You can add additional 
information to the Medical Outcomes section for up to ten days using the facility license number, the 
injury ID number and the reporting party email address.   
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IX.  Submitting and Printing Reports 

Can I edit this report after I submit it? 
After you have submitted the Injury Report, you cannot edit it.  You can add to the Medical Outcomes 
section of the report for up to ten days from the date of injury listed in the initial injury report.  If 
additional detail becomes available after submitting your report, contact your licensing specialist.   

Can I save my report and complete it later? 
No.  There is no mechanism for saving a partially completed report.  It is recommended that you file 
your report when you have sufficient time to finish it.  In order to protect the information in the system, 
the Injury Report session ends after 10 minutes of inactivity.   

Can I review my report before I submit it? 
Yes.  When you click submit report, the system displays the “Click to review” link. Select the link and 
a pop-up window displays so you can verify the report information is correct.  Click Cancel to return 
to the report to make changes.  When you are ready to print and submit the report, click OK. 

How do I print the report? 
When you select “Submit a report”, the system prompts you to print the report.  You are required to 
keep a copy of the report in the child’s record and provide a copy to a parent or legal guardian.   

When you click submit, the system displays a pop-up window showing a copy of the report.  Double-
click the report to open it.  Once open, you can save or print the report.  Top print the report, click the 
Printer Icon, or click File > Print.   

The system will also send you an email with an attachment of the report.   

Note: You must have a printer attached to your computer or available on your network to print the 
report. 

How do I get my Report ID? 
The system generates the Report ID when you submit the report.  The ID number displays in the 
Print Report Pop-up window, and on the PDF copy of the report.   

When submitting a report, I see the option for creating another report.  
What does this mean?  
Each report follows a single child.  When an incident occurs involving more than one child, you can 
create additional reports based on the initial report.  The system will generate another injury report 
and include the incident information.  All you will need to enter is the information for the specific child.   
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